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Arts & Letters Clip Art Viewer





Chapter One: Introduction

What is the Clip Art Viewer?

The Arts & Letters Clip Art Viewer allows you to view and copy images on your Arts & Letters
CD. In addition, you can use the Viewer to print a complete clip-art handbook (or any lesser se-
lection of the clip art images).

The Clip Art Viewer displays thumbnails of the images in rows in the center of its main screen. 
You can view more thumbnails using the scroll With the Clip Art Viewer, you bar. can view 
selected images full-screen, either singly or in a slide show. You can also copy a selected image 
to the Windows Clipboard in BMP or WMF format for use in other applications.

If You Need Help
If you need Help, look first at the Hint Line at the bottom of the Clip Art Viewer main screen.
As you move the cursor around on the screen, the Hint Line identifies the various components of
the interface and lists options for actions, where appropriate.

First-time users should select the Interface topic in the Help Contents screen for a quick tour of
the interface. When you see the pointer hand, you have found a hot spot for information.

For help information about any aspect of the Clip Art Viewer while you are using the program,
press F1 or click on the i button at the bottom of the main screen and the Help Contents screen
will appear.

When in Help, you can click on any of the blue highlighted words for an instant definition. To re-
turn to the last topic, click on the Back button. To return to a topic you had recently investigated
in the Help system, click on History to display a list of the last 40 topics you have visited. You
can return to the Table of Contents by clicking on the Contents button.

For help on a specific item, click on the Search button in the Help window button bar. Type in a
subject or keyword and then click on Go To (Windows 3.×) or Display (Windows 95).

Note that while using Help you can click the right mouse button to display a list of functions that
allow you to add your own comments to the Help screens, bookmark topics and print them.

Should you encounter any problems or require assistance, please contact us for Technical Support
by E-mail: support@arts-letters.com, phone (972) 661-8960 or fax (972) 661-5429. Our office
hours are 8:30 a.m. to 6:30 p.m. CST, Monday through Friday. If possible, be at your computer
when you call.

Printing a Clip-Art Handbook
The Arts & Letters Clip-Art Viewer can be used not only to view and copy WMFs but to print a
complete clip-art handbook or any portion thereof (e.g., “Animals” and “Marine” only). To print
the handbook, click on the Viewer icon in the Arts & Letters program group.
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The images shown above and elsewhere in this manual are from Arts & Letters Classic
Clip Art.

Either click on the Print button or pull down the File menu and choose Print. The Thumbnail
Print Dialog will appear.

Click on Print. The Clip-Art Viewer will print your handbook.
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An index of the images contained in your clip-art handbook is appended to this document.

Printing Options
As described above, the Thumbnail Print Dialog box defaults will produce a clip-art handbook,
but the dialog box offers you two other printing options.
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Ÿ Print Selected Thumbnails — This prints only the thumbnails that you have selected. (See
Chapter Two for the selection process.)

Ÿ Print Selected Categories — Using the window at the top of the dialog box, you can select
categories for printing.

In addition, you can customize your print job by using the following options:

Ÿ Layout — Print pages with five images across and five down (default) or three images across
and four down.

Ÿ GrayScale — Select the Gray Scale option to automatically convert the images to grayscale
prior to printing. This conversion does not affect the display or the images. (When printing
a draft to a color printer, chose this option to conserve ink.)

Ÿ Quick Spool — When you are faxing or printing to a file, turn the Quick Spool  option off so
that all multiple page print jobs will be treated as a single document and the “end of docu-
ment” command will not be issued until the last page is complete. If you are not faxing or
printing to a file, this option should be on to conserve disk space and for faster printing.

Ÿ Printer Font — The default font with with labels and descriptions will be printed is Arial, but
you can choose any font installed on your system. Scroll through a listing of fonts and pre-
view fonts before you make your selection.

Ÿ Set printer font to Arial — Immediately return the printer font to Arial.

Ÿ Print file information — You can specify the printout to contain not only a thumbnail of each
image but file details as well. This information includes the DOS file name, date, size, and
dimensions.
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The Arts & Letters Clip-Art Viewer allows you to view the WMF images on the CD. If you wish
to use the EPS images, you should still use the Viewer to locate the correct image. The file names
are the same for both types of image. The Clip-Art Viewer also allows you to print a clip-art
manual.

To start the Viewer, click on its icon in the Arts & Letters program group. The viewer will open.
Change categories by clicking on a name in the upper left hand window. The thumbnail represen-
tations of the images will appear in the center of the Viewer; the Zoom Box in the upper right-
hand corner. Use the scroll bar to view more thumbnails.

To select an image for viewing full-screen or printing, click once on the image with the  left
mouse button. Clicking on another image does not deselect the first image; if you wish to dese -
lect an image, click on it again with the left mouse button. To select all the images in a category,
click on the Select All button. Images that are selected in this manner will be framed in black. To
deselect all images, click on the Clear button.

Click on a thumbnail image with the right mouse button to view it in
the Zoom Box. The image in the Zoom Box can be copied into another
application, such as Word or PageMaker.
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If you click on the image in the Zoom Box, the Zoom Box displays the Selection Menu, which
offers two copying options: Copy to Clipboard (DIB) and Copy to Clipboard (WMF). You are
also given three display options.

If you wish to view only one thumbnail at a time and would rather browse from among the
names of the clip-art images, pull down the View menu and deselect Thumbnail Display. The
program will contract to a smaller interface, which may be useful if video display space available
to you is limited. Thumbnails you select (highlight) will appear in the Zoom Box.

Viewing Images Full Screen
Images that  are selected by single-clicking (and are framed in black) can be previewed Full
Screen. To do so, click on the Full Screen button.
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Use the arrow keys to browse forward and backward through the images that you have selected
for preview. In the example above, all of the images in the Animal category have been selected;
therefore, all are available for full-page preview. Note that you can also print the image being
previewed.

You can also use the Slide Show controls to view the images you have selected, automatically
and at either 2 or 5 second intervals. The controls include Play, Pause, and Stop.

Save As...
The Viewer allows you to save selected files in several popular formats:  BMP, JPG (JFIF &
JTIF), PCX, PNG, PSD, TGA, and TIF. Pull down the File menu and choose Save As.... Viewer
prompts you to choose a format, then reads the original Windows Metafile to create the new im-
age.

Copying Images to the Clipboard 
Images that are selected by double-clicking (that are framed in red) can be copied to the Windows
Clipboard in either WMF (vector) or DIB (bitmap) format. To do so, pull down the Edit menu,
select Copy to the Clipboard, and choose WMF or DIB. You can check the contents of the Win-
dows Clipboard by pulling down the Options menu and choosing View Clipboard.
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Copying images to the Clipboard is a quick way to paste images into another application. Re-
member, however, that the image you copy will be WMF (or DIB), not EPS. If you are using a
PostScript printer, you may prefer to use the EPS version of the image.

Using the Find Feature
The Clip Art Viewer's Find feature allows you to perform a search for an image in any clip art
category on your Arts & Letters CD. This feature comes in handy when you want to quickly find
an image without changing categories or scrolling through the thumbnail display. You can search
for one image or for a group of images simultaneously.

Searching for a Single Image
To perform a search on a single image:

1. Click on the Find button {bmc fnd_butn.shg} at the bottom of the main screen. The Find dia -
log box will appear with a list of image descriptions.

2. Use the scroll bars or type into the edit box above the Description list.

3. When the Description list scrolls to the desired item, double-click on it with the mouse. The
item will appear in one of the Search fields to the right.

4. Click on the Find button. When the dialog box disappears you will notice the Categories list
box at the top of the main screen displays the words "Find Query Active" and the search
results are listed in the Description list box. The desired image thumbnail will also be
displayed in the upper-right corner of the main screen.

Note: There are more descriptions available from the Description list in the Find dialog box than
there are images on the Arts & Letters CD. This is because the Clip Art Viewer breaks up many
of the descriptions so that they will be easier to locate. For example, to locate an image of a Vic-
torian house, you can search for either "Victorian" or "house" and the Find feature will locate the
desired image.

Searching for Multiple Images
There may be cases where you want to locate several images at once. For example, you may want
to locate all images with the words "girl" or "doll" in the description. With the Find feature, you
can search for both "girl" and "doll" simultaneously and the Clip Art Viewer will locate all im-
ages whose descriptions contain either of these words.

5. To perform a search on multiple items:

6. Click on the Find button and the Find dialog box will appear.

7. From the Description list, double-click on the desired items you wish to search for. The items
will appear in the Search fields to the right. You may search for as many as five items at
a time.

8. Click on the Find button. When the dialog box disappears, your search results will be dis-
played.

Note: The Find feature is capable of locating up to 250 items which fit the search criteria.
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Selecting a Previous Search
If you have previously performed a search, the Clip Art Viewer remembers the last ten items you
have searched for and lists them for you in the Find dialog box. This feature makes it especially
quick and easy to perform a search that you have previously conducted.

9. To select a previous search:

10. Click on the Find button and the Find dialog box will appear.

11. From the drop-down list box at the top of the screen, click on a previous search item. The
Search fields on the right side of the dialog box will display the data you entered for your
previous search.

12. Click on the Find button. When the dialog box disappears, your search results will be dis-
played.

Search Tips
Ÿ In performing any type of search, you do not have to use the Description list; you can type di-

rectly into the Search fields in the Find dialog box. To activate a Search field for data entry,
click on it with the mouse.

Ÿ To halt a search at any time, press the Esc key on the keyboard.

Ÿ You can quickly clear the results of a search by either clicking on a category from the Cate-
gories list box at the top of the main screen or on the Find button at the bottom of the
screen.

Encapsulated PostScript (EPS) vs. the Windows Metafile (WMF)
There are several differences between WMF and EPS files:

Ÿ The line segments in an EPS image are composed of a combination of curves and straight
lines; those in a WMF image are all straight lines.

Ÿ A curved line in an EPS image will really be curved; whereas, a “curved” line in a WMF im-
age will actually be composed of many straight lines approximating the curve.

Ÿ Because there can be fewer points in an EPS image, it will generally be smaller than a corre -
sponding WMF image.

As we said before, if you will be printing to a PostScript printer, you probably should use the
EPS version of a clip art image. You can use the WMF version if you wish, but the EPS version
will take full advantage of your PostScript printer’s capabilities. If you will be printing to a non-
PostScript printer, you must use the WMF version.

The reason that you must use the WMF version is that non-PostScript printers will not print an
EPS image — they print its screen representation instead, which is usually a low resolution pic-
ture used for placement only. The EPS files, however, in order to be useful in as many applica -
tions as possible, have been created without a screen representation. Therefore, there is literally
nothing for the non-PostScript printer to print.

Using the WMF and EPS Files
In general, there are two ways in which an art object, in a file format such as a Windows Metafile
or an EPS file, can be inserted into another document:
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Ÿ From an open art application, such as Arts & Letters Clip-Art Viewer or EXPRESS,  copy (or
cut) the art object to the Windows Clipboard, then paste it into a second open application.

Ÿ With the target application open (e.g., Word, PageMaker or EXPRESS) choose the import op-
tion for that application and name the WMF or EPS file to be brought in. 

Windows applications that support importing of image files will offer a command option such as
Import (Arts & Letters),  Place (PageMaker),  or  Insert (Word). Check the documentation for
your application.

If you wish to alter an image, you should first import it into a vector graphics application such as
Arts & Letters EXPRESS, change it, then export it from your  Arts & Letters  product as a new
WMF file. (See “Exporting Images from Arts & Letters,” page 10.)
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The images in your Arts & Letters product are not only available in WMF and EPS format but in
YAL format, as well. We have organized these images into clip-art collections that can be ac -
cessed using the Arts & Letters Clip-Art Manager in EXPRESS or DRAW.

You can double the redraw speed of complex artwork by clicking on the Accel-O-Draw button on
the EXPRESS menu bar.

Exporting Images from Arts & Letters
After having altered one of the images in Arts & Letters, you may wish to use the image in an-
other application. We will describe exporting the image as an EPS file; the procedure for other
export formats is similar.

To export the image from Arts & Letters as an EPS image file:

13. Pull down the File menu and choose Export.

14. The Export dialog box will appear.
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15.

16. From the “Export File As” drop-down menu, choose Encapsulated PostScript (*.EPS).

17. Select the Export Area, if you wish it to be different from the default, “Selected Objects.”

18. Click on the Setup button.

19.

The default settings in the Setup dialog box are good for most other Windows applications, but
you may wish to check the documentation or Help files for the target application before export -
ing.

The “Screen Image” area has nothing to do with the actual EPS image file; it merely sets header
information that is used by the target application to show a representation of the actual file, usu-
ally for placement. As such, you can change the resolution to 75 dpi to save storage. We also rec-
ommend choosing TIFF rather than WMF for screen image.
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Importing Images into EXPRESS
Although the images in the Clip-Art Manager are duplicates of the EPS and WMF images, you
may on occasion wish to import an image rather than use the Clip-Art Manager.

To import an EPS image file:

20. Pull down the File menu and choose Import. The Import dialog box will appear.

21.

22. In the “List Files of Type” drop-down menu, select EPS PostScript.

23. Address the drive containing the CD.

24. Select the image you wish to import, using the file name that appears in the Clip-Art Viewer.

25. You can use the Preview button, but the thumbnail will take as long to appear as the file
would to import. You may as well see the file full-size, to properly evaluate its appear-
ance.

26. Click on OK.

Arts & Letters  will begin to import the image. As we noted previously, the import process for
larger images may take a few moments, although most images will import more quickly. When
the import process is finished, the image will appear in your Arts & Letters file identified as a
“GED_group.”
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If you wish to change either the black or the white color to another color, and if you are using
Arts & Letters EXPRESS, you have two options.

Changing Colors Using EXPRESS’ Color Filters
EXPRESS allows you to change the color of all like-colored objects in the image to another color
at once, without having to select and change each and every object.

To change all the black objects in the image to another color:

27. Select the image or images whose colors you wish to alter.

28. Point on the Color button in the Style bar and hold down the right mouse button.

29. From the Content menu that appears, select Color Filters. The Color Filters dialog box will
appear.

30.  
31. Artistic ModeTechnical Mode

32. You can use the Color Filters “Artistic” mode to change the colors, but for this operation, it
is easier to use the “Technical” mode. In the Technical dialog box, use the slider bars to
alter the color black. A preview swatch will show you how the new color will appear.
(You should deselect the color white.) We have created a light, blue-green to replace the
black.

33. Click on Apply.

EXPRESS will recolor all the black objects to the new color.
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Returning a Colored Image to Black & White
For some documents, you may wish to use a simple black & white version of a colored image.
Using EXPRESS’ Color Filters as described above, you can easily change a multicolored image
to its original black & white. There are several methods of achieving this result; you might try
using “Brightness/Contrast” in the Artistic mode or “Brightness” in the Technical mode.

Be sure to deselect the color black in the preview window; then move the Filter slider bars until
the colors of the preview swatches are all white. Click on Apply.

Changing Colors Using the Name Colors Function
An alternative to using EXPRESS’ Color Filters is to rename the colors.

To change all the black objects in the image to another color:

34. Select one of the black objects.

35. If you are using Arts & Letters EXPRESS, you do not have to break apart the GED_group.
Simply double-click to select within the group, watching the Color button on the Style
Bar. When you have selected a black object, it will show a black color sample.

36. Click on the Color button with your right mouse button to open the Custom Color dialog
box. (If you click with your left mouse button, you will open the Color Palette box. If
you have done so, click on the Custom button.)

37.

38. Choose CMYK as your color Model.

39. You can perform this coloring operation using any of the color models, but we’ve chosen
CMYK for the demonstration.

40. Note that the black in this antique image is defined as 100% Cyan, 100% Magenta, 100%
Yellow, and 0% Black.

41. Name the black color using the Name button. Any original name will do; we chose “Color
1.” (You should avoid using names that are already defined, as doing so will cause any
other objects in your file that are colored with that name to turn black.)

42.
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43. Click on the Name button.

44. Arts & Letters attaches the name “Color 1” to the color defined as 100% Cyan, 100% Ma-
genta, 100% Yellow, and 0% Black.

Now all you have to do is change the definition of “Color 1.” To do so:

45. Using the slider bars, create a new color, making sure that the color you choose doesn’t have
a name already attached to it. We’ve chosen 100% Cyan, 20% Magenta, 60% Yellow,
and 0% Black — a bright green.

46.

47. Click on the Name button again and type in the name you previously used for the black.

48. When you click on the Name button, Arts & Letters will display a warning box:

49.

50. Click on Yes.

Arts & Letters will update the formerly “black” objects in the image, coloring them all with the
new color. This method, while somewhat roundabout, is much easier than trying to find and se-
lect all of the black objects in the image and recolor each of them.
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